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Why make online documents accessible?

In accordance with Section 508 of the Rehabilitation Act and Section 255 of the 
Communication Act, the final rule of the U.S Access Board published on January 18, 
2017 states that under the law, federal agencies, contractors, and employers must 
comply with online accessibility standards. As a federal and state funded entity, the 
University of Louisville must comply with these standards.

“The Rehabilitation Act of 1973 requires access to programs and activities that are 
funded by Federal agencies and to Federal employment. The law also established 
the Access Board (section 502). Later amendments strengthened requirements for 
access to electronic and information technology in the Federal sector (Section 508).  
With passage the Patient Protection and Affordable Care Act in 2010, a new provision 
(section 510) was added to address access to medical diagnostic equipment. The 
Board plays a lead role in developing and maintaining standards for electronic 
and information technology under section 508 and medical diagnostic equipment 
covered by section 510.”

 https://www.access-board.gov/the-board/laws/rehabilitation-act-of-1973

WCAG are standards that are overall acknowledged as technical requirements 
created by the World Wide Web Consortium (W3C) that explains who to make web 
content more accessiblity to those with disabilities. WCAG Version 2.0 was publiched 
in December 2008 and is the most complete and up-to-date guidelines for web 
accessibility. However, a recommendation to WCAG Version 2.1 has been published 
in June 2018. The WCAG Version 2.1 functions as an extension to Version 2.0 and it 
not final in content.

“On August 7, 1998, President Clinton signed into law the Rehabilitation Act 
Amendments of 1998 which covers access to federally funded programs and 
services. The law strengthens section 508 of the Rehabilitation Act and requires 
access to electronic and information technology provided by the Federal 
government. The law applies to all Federal agencies when they develop, procure, 
maintain, or use electronic and information technology. Federal agencies must 
ensure that this technology is accessible to employees and members of the public 
with disabilities to the extent it does not pose an undue burden. Section 508 speaks 
to various means for disseminating information, including computers, software, and 
electronic office equipment. It applies to, but is not solely focused on, Federal pages 
on the Internet or the World Wide Web. It does not apply to web pages of private 
industry.

The Board is responsible for developing accessibility standards for such technology 
for incorporation into regulations that govern Federal procurement practices. The net 
result will be that Federal agencies will have to purchase electronic and information 
technology that is accessible except where it would cause an undue burden. The 
law also provides a complaint process under which complaints concerning access to 
technology will be investigated by the responsible Federal agency.”

https://www.access-board.gov/the-board/laws/rehabilitation-act-of-1973#508

Purpose

Rehabi l i tat ion Act of  1973

Web Content Accessibi l i ty 
Guidel ines (WCAG)

Section 508

Federal Electronic and Information 
Technology

 https://www.access-board.gov/the-board/laws/rehabilitation-act-of-1973
https://www.access-board.gov/the-board/laws/rehabilitation-act-of-1973#508
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WCAG 2.0

As a resource, this guide follows the Web Content Accessibility Guidelines (WCAG) Version 2.0 and Web Accessibility Initiative (WAI) 
documentation for best practices. Authors routinely deliver PDF documents as web content, so it is important to understand what 
constitutes an accessible PDF file. The most reliable way to generate an accessible PDF is to create a Tagged PDF file. To promote 
continuity across WAI documents and to assist in understanding accessibility principles, they have chosen to place each PDF checkpoint 
under the most appropriate one of the four WCAG 2.0 Guidelines. 

WCAG 2.0 Guidelines
WCAG Guideline 1: PRESENTATION
WCAG Guideline 2: INTERACTION
WCAG Guideline 3: COMPREHENSION
WCAG Guideline 4: TECHNOLOGY CONSIDERATIONS

PDF Checkpoints
WCAG Guideline 1: PRESENTATION

PDF Checkpoint 1: 
Ensure That The Text of the Document is Accessible

Checkpoint 1.1: Render Characters and Words in Reading Order within the Page
Checkpoint 1.2: Separate words explicitly with spacing characters
Checkpoint 1.3: Use soft hyphens and hard hyphens appropriately
Checkpoint 1.4: Use the ActualText attribute
Checkpoint 1.5: Ensure that all characters codes map reliably to Unicode

PDF Checkpoint 2: 
Provide Text Alternatives for Images and Graphics

PDF Checkpoint 3: 
Provide Structural Grouping

Checkpoint 3.1: Provide logical structure
Checkpoint 3.2: Tag artifacts in the page contents with /Artifact

PDF Checkpoint 4: 
Design for User Control of Color and Contrast
Checkpoint 4.1: Avoid drawing rectangles behind text that are not background 	
elements
Checkpoint 4.2: Text should not be placed on top of images
Checkpoint 4.3: Avoid the use of Color as the Only Means to Convey Information

PDF Checkpoint 5: 
Identify the Natural Language of all Text in the Document
Checkpoint 5.1: Identify the documents primary language
Checkpoint 5.2: Identify when a language change occurs on the page

WCAG Guideline 2: INTERACTION
PDF Checkpoint 6: 
Document Navigation
Checkpoint 6.1: Use bookmarks to provide navigation aids into a document.
Checkpoint 6.2: Use links within a document
Checkpoint 6.3: If the value of the link does not describe the target clearly and 
accurately, provide Alt attributes
Checkpoint 6.4: Provide a clear descriptive name for all form fields

WCAG Guideline 3: COMPREHENSION
PDF Checkpoint 7: 
Provide Expansions for Acronyms and Abbreviations

WCAG Guideline 4: TECHNOLOGY CONSIDERATIONS
PDF Checkpoint 8: 
Set Document Protections to Permit Access
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Adobe Acrobat Pro DC

Adobe Acrobat Pro is a paid software 
by Adobe that primarlily works with 
PDFs (portable document format). In the 
program, you can edit PDFs, add text, 
replace pictures, create forms. and make 
accessible PDFs. If you do not have the 
paid version of the program, you will not be 
able to access the tools that can make ADA 
complaint doucments. 

Acrobat Pro DC or as part of the Adobe Creative Cloud subscription are version 
that has the tools to create and validate PDFs to meet accessbility requirements for 
people with disabilities. 

DO NOT BUY ACROBAT STANDARD DC. Although this is a paid version of Acrobat, 
this version does not have the tools for accessibilty as well as the capabiltiy to turn 
scanned documents into editable and searchable PDFs. 

Adobe Reader DC is the free program that only allows people to view, print, and 
annotate PDFs. You cannot create a PDF, export, set security parameters, or make 
PDFs accessibility standard compliant.

Accessibi l i ty Workspace

Use the Accessibility Full Check command 
to perform a thorough check for many 
characteristics of accessible PDFs, such 
as the use of alternative text on images, 
the presence of tags, document language, 
and fonts that can be mapped reliably to 
Unicode text.

It is possible to choose which kinds of 
accessibility issues to look for in Full Check 
by using the Accessibility Checker Options. 
There are also options to view and save 
the results. 

Page Thumbnails

Attachments

Bookmarks

Content Panel

Tag Panel

Accessibility Checker

Order

Model Tree

Accessibility Tools

Right Panel

Left Panel
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Accessibi l i ty Checker 

Use Full Check command under the 
Accessibility Tool, to perform a thorough 
check for many characteristics of 
accessible PDFs, such as the use of 
alternative text on images, the presence of 
tags, document language, and fonts that 
can be mapped reliably to Unicode text.

It is possible to choose which kinds of 
accessibility issues to look for in Full Check 
by using the Accessibility Checker Option. 
There are also options to view and save 
the results. 

To run the Accessibility Full Check:

1.  Under the Tools tab, select Accessibility.

2. On the right side panel, select Full Check.

3. An Acessibility Checker Options dialog box will open. Make sure the Page Range 
is set to All pages in document and that all the checkboxes under Checking Options 
are selected, then click Start Checking.
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4.  After the check is complete, the results are displayed via the Accessibility Checker 
panel.

Accessibility Checker Panel

Once a report has been run, the issues that have been found are displayed in the 
Accessibility Checker panel. The results tree displays one of the following states for 
each rule check (See “Figure 6. Accessibility Rule Check State”).

Passed:			   The item passed this accessible check.

Passed Manually: 		 The item was marked passed by manual inspect.

Skipped By User: 		 The rule was not selected in the Accessibility Checker 
			   Options dialog box.

Needs Manual Check: 	 The Full Check feature could not check the item 
			   automatically. Verify the item manually.

Failed: 			   The item did not pass the accessibility check.
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Container Elements

Container elements are the highest level of element and provide hierarchical grouping for other block-level elements.

Document 		  Document element. The root element of a document’s tag tree.

Part 	 		  Part element. A large division of a document; may group smaller units of content together, such as division 		
			   elements, article elements, or section elements.

Div 			   Division element. A generic block-level element or group of block-level elements.

Art			   Article element. A self-contained body of text considered to be a single narrative.

Sect			   Section element. A general container element type, comparable to Division (DIV Class=“Sect”) in HTML, which 
			   is usually a component of a part element or an article element.

Heading And Paragraph Elements

Heading and paragraph elements are paragraph-like, block-level elements that include specific level heading and generic paragraph (P) 
tags. A heading (H) element should appear as the first child of any higher-level division. Six levels of headings (H1 to H6) are available for 
applications that don’t hierarchically nest sections.

Label  and List  Elements

Label and list elements are block-level elements used for structuring lists.

L			   List element. Any sequence of items of similar meaning or other relevance; immediate child elements should 		
			   be list item elements.

Ll	 		  List item element. Any one member of a list; may have a label element (optional) and a list body element 	
			   (required) as a child.

LBL			   Label element. A bullet, name, or number that identifies an element from others in the same list.

LBody			   List item body element. The descriptive content of a list item.

Standard PDF Tags

This section describes the standard tag types that apply to tagged PDFs. These standard tags provide assistive software and devices 
with semantic and structural elements to use to interpret document structure and present content in a useful manner.

The PDF tags architecture is extensible, so any PDF document can contain any tag set that an authoring application decides to use. In 
other words, the software that the original document was created in defines the standard tags applied within the file. For example, a PDF 
can have XML tags that came in from an XML schema. However, additional information is often neccesary for accurate notation. 

Custom tags that you define (such as tag names generated from paragraph styles of an authoring application) need a role map. The role 
map matches each custom tag to a standard tag here. When assistive software encounters a custom tag, the software can check this role 
map and properly interpret the tags. 

Tagging PDFs by using one of the methods described here generally produces a correct role map for the document.
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Special  Text Elements

Special text elements identify text that isn’t used as a generic paragraph (P).

BlockQuote 		  One or more paragraphs attributed to someone other than the author of the immediate surrounding text.

Caption 			  Caption element. A brief portion of text that describes a table or a figure.

Index			   Index element. A sequence of entries that contain identifying text and reference elements that point out the 
			   occurrence of the text in the main body of the document.

TOC			   Table of contents element. An element that contains a structured list of items and labels.

TOCI			   Table of contents item element. An item contained in a list associated with a table of contents element.

Table Elements

Table elements are special elements for structuring tables.

Table			   A two-dimensional arrangement of data or text cells that contains table row elements as child 
			   elements and may have a caption element as its first or last child element.

TR	 		  One row of headings or data in a table; may contain table header cell elements and table data cell elements.

TD			   Table data cell element. A table cell that contains nonheader data.

TH			   A table cell that contains header text or data describing one or more rows or columns of a table.

Inl ine-Level  Elements

Inline-level elements identify a span of text that has specific formatting or behavior. They are differentiated from block-level elements.

BibEntry			   Bibliography entry element. A description of where some cited information may be found.

Quote	 		  Quote entry element. An inline portion of text that is attributed to someone other than the author of the text 
			   surrounding it.

Span			   Span entry element. Any inline segment of text; commonly used to delimit text that is associated with a set of 
			   styling properties.

Special Inl ine-Level  Elements

Similar to inline-level elements, special inline-level elements describe an inline portion of text that has special formatting or behavior.

Figure			   Figure entry element. A graphic or graphic representation associated with text.

Form	 		  Form entry element. A PDF form annotation that can be or has been filled out.

Formula	 		  Formula entry element. A mathematical formula.

Link			   Link entry element. A hyperlink that is embedded within a document. The target can be in the same 
			   document, in another PDF document, or on a website.

Note			   Note entry element. Explanatory text or documentation, such as a footnote or endnote, that is referred to in 
			   the main body of text.

Reference		  Reference entry element. A citation to text or data that is found elsewhere in the document.
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Accessibi l i ty Permission Flag

A document author can specify that 
no part of an accessible PDF is to be 
copied, printed, extracted, commented 
on, or edited. This setting could interfere 
with a screen reader’s ability to read the 
document, because screen readers must 
be able to copy or extract the document’s 
text to convert it to speech.

Image-Only PDF

Reports whether the document contains 
non-text content that is not accessible. If 
the document appears to contain text, but 
doesn’t contain fonts, it could be an image-
only PDF file.

Tagged PDF

If this rule check fails, the document isn’t 
tagged to specify the correct reading order.

If the report shows that this section failed, it is required that you turn on the security 
settings that will allow accessibility.

To fix:

1.  Go to File > Properties > Security

2. Under the Document Security section, select No Security from the drop-down.

Scanned documents most often appear as image-only PDFs. We do not recommend 
scanning documents as a method to generate PDFs.  Although there is a possible fix, 
it is extremely inaccurate unless the text is minimal. Creating a PDF from the original 
file is highly recommended and the easier approach to fixing this issue. However, you 
may attempt to manually fix this rule through scanning the document for recognizable 
text. Some aesthetic alteration in the letters and words may result.

To fix:

1.  Go to Tools > Enchanced Scans

2. On the taskbar above, click Recognize Text > In This File > Recognize Text (bold)

Checking if the PDF is tagged should be the first thing you should immediately try to 
fix because it may automatically fix other tagging-related issue within the file. 

To fix:

1.  In Accessibility Checker panel, right click Tagged PDF and click Fix from the drop-
down. Acrobat automatically adds tags to the PDF.



13

DIGITAL WEB SERVICES

The full check feature is not capable of verifying the reading order automatically; 
therefore, a manual check over the document’s reading order is required. In the 
event that changes are needed within the reading order, open the Order panel 
and drag contents within the list. If the Order panel icon does not show, right-click 
anywhere on the left sidebar. A drop-down list will open, select Order Panel.

To fix:

1.  In Accessibility Checker panel, right-click Primary Language and click Fix from 
the drop-down. 

2. A pop-up box called, Set Reading Language will appear, select the appropriate 
language for the document and then click OK.

Logical  Reading Order

Verify this rule check manually. Make sure 
that the reading order displayed in the Tags 
panel coincides with the logical reading 
order of the document.

Primary Language

Setting the document language in a PDF 
enables some screen readers to switch 
to the appropriate language. This check 
determines whether the primary text 
language for the PDF is specified. If the 
check fails, set the language.

Tit le

Reports whether there is a title in the 
Acrobat application title bar.

To fix:

1.  In Accessibility Checker panel, right-click Title and click Fix from the drop-down. 
In some instances, Acrobat will automatically fix the title. 

2. If this doesn’t occur, a Description dialog box will appear. Uncheck Leave As Is, 
below the Title field and type the correct title, and click OK.
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Bookmarks

A fail in bookmarks occurs when a 
document has 21 or more pages, but 
doesn’t have bookmarks that parallel the 
document structure.

Color Contrast

When a color contrast check fails, it’s 
possible that the document contains 
content that isn’t accessible to people who 
are color-blind.

To fix:

1.  In Accessibility Checker panel, right-click Bookmarks and click Fix from the drop-
down.

2. In the Structure Elements dialog box, select the elements you want to use as 
bookmarks, and click OK.

This section is a manual fix and must adhere to the guidelines in WCAG section 1.4.3 
or include a recommendation in the PDF viewer to use high-contrast color.

To fix:

1.  In Edit, click Preference (Windows) or in Acrobat, click Preferences (Mac).

2. Accessibility > uncheck Replace Document Colors > select Use High-Contrast 
Colors. Choose a color combination from the drop-down, then click OK.
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Tagged Content

A tagged content check reports whether 
all content in the document is tagged. 
You must make sure that all content in the 
document is either included in the Tags 
tree, or marked as an artifact.

To fix:

1.  In Accessibility Checker panel, left-click Tagged Content to decollaspe the list of 
elements.

2. Right-click Element 1, click Show in Content Panel from the drop-down.

3. In the Content Panel, locate the highlighted content and right-click > Create 
Artitifact from drop-down. 

4. In the Create Artifact dialog box, select the appropriate Artifact Type, then click 
OK. Repeat Step 1-4 until all elements are tagged.
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Tagged Annotations

This rule checks whether all annotations 
are tagged. Make sure that annotations 
such as comments and editorial marks 
(such as insert and highlight) are either 
included in the Tags tree or marked as 
artifacts.

To fix:

1. In Accessibility Checker panel, left-click Tagged Annotations to decollaspe the list 
of failed elements. Right-click Element 1, click Show in Content Panel from the drop-
down and then the Content Panel will automatically highlight the failed element. 

2. Once you have indentified the highlighted untagged content, click the option icon, 
and select Find in the drop-down.

3. A Find Elements dialog box will open. Select Unmarked Annotations from the 
drop-down. Click the Search Page circle > Find.

NOTE: Your selection for within the Find drop-down menu should be determined by 
what you think is best used to appropriately tag the content.

4. The Type that will appear in the dialog box are the untagged annotation within the 
Page. Select Tag Element, for the untagged content item.

4. A New Tag dialog box will appear. Select the appropriate type drop-down > OK. 
In Find Element dialog box, click Find Next. Repeat steps 3-4 until all unmarked 
annotations have been tagged.
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Tab Order

Because tabs are often used to navigate 
a PDF, it’s necessary that the tab order 
parallels the document structure.

Character Encoding

Specifying the encoding helps PDF viewers’ 
present users with readable text. Most 
character-encoding issues aren’t repairable 
within Acrobat.

Tagged Mult imedia

The tagged multimedia checks whether all 
multimedia objects are tagged. Make sure 
that content is either included in the Tags 
tree or marked as an artifact.

To fix:

1.  In Accessibility Checker panel, right click Tab Order and click Fix from the drop-
down. Acrobat will automatically fix the tab order.

To ensure proper encoding, do the following:

• Verify that the necessary fonts are installed on your system.
• In the original document, change the font, and then re-create the PDF.
• Re-create the PDF file with a newer version of Acrobat Distiller.

To fix:

1.  In Accessibility Checker panel, left-click Tagged Multimedia to decollaspe the list 
of elements. Right-click Element 1, click Show in Content Panel from the drop-down.

2. In the Content Panel, locate the highlighted content and right-click > Create 
Artitifact from drop-down. 

3. In the Create Artifact dialog box, select appropriate Artifact Type, click OK. 
Repeat Step 1-4 until all elements are tagged.
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Screen Fl icker

Elements that make the screen flicker, 
such as animations and scripts, can 
cause seizures in individuals who have 
photosensitive epilepsy. These elements 
can also be difficult to see when the screen 
is magnified.

Scripts

Content cannot be script-dependent 
unless both content and functionality are 
accessible to assistive technologies. Make 
sure that scripting doesn’t interfere with 
keyboard navigation or prevent the use of 
any input device.

Timed Responses

This rule check applies to documents that 
contain forms with JavaScript. If the rule 
check fails, make sure that the page does 
not require timed responses. Edit or remove 
scripts that impose timely user response so 
that users have enough time to read and 
use the content.

Navigation Links

For URLs to be accessible to screen 
readers, they must be active links that are 
correctly tagged in the PDF. 

Tagged Form Fields

In an accessible PDF, all form fields are 
tagged and are a part of the document 
structure. In addition, you can use the tool 
tip form field property to provide the user 
with information or to provide instructions.

If the Screen Flicker rule fails, manually remove or modify the script or content that 
causes screen flicker in the original program the PDF file was created in.

*This section of the Accessibility Checker is only applicable to interactive PDFs.

Check the scripts manually. Remove or modify any script or content that 
compromises accessibility in the original program the PDF file was created in.

*This section of the Accessibility Checker is only applicable to interactive PDFs.

Manually edit or remove scripts that impose timely user response so that users have 
enough time to read and use the content. The scripts can be modified in the original 
program the PDF file was created in.

*This section of the Accessibility Checker is only applicable to interactive PDFs.

If this failure occurs, check navigation links manually and verify that the content does 
not have more than two identical links. Also, provide a way for users to skip over 
URLs that appear multiple times.

*This section of the Accessibility Checker is only applicable to PDFs with hyperlinks.

To Fix:

1.  On the right panel, select Autotag Form Fields. Acrobat automatically adds tags to 
the form fields.
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If the previous fix did not work, the element must be manually tagged.

1.  Identify the untagged form field by clicking on the field list. Upon clicking, the 
content will highlight within the document. 

2. On the right panel, select Reading Order. A Reading Order dialog box will open, 
you will noticed that the buttons are unclickable. Drag box, to the side of your screen 
vvso that the document is viewable.
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3. Drag and draw a rectangle over the form field that was highlighted. Buttons within 
the Reading Order dialog box will become avaliable and click, Form Field. 

4. Close the dialog box and return to the failed Tagged Form Field list in 
Accessibility Checker. Right click Tagged Form Field > Check Again from the drop-
down. 

5. Repeat Steps 1 - 4 until the failed Tagged Form Field list passes and a green check 
mark shows.

To Fix:

1.  Identify the Field by clicking on the failed field in the Accessibility Checker and will 
become highlighted in document. Select Prepare Form from the tool panel. 

Field Descript ions

For accessibility, all form fields need a text 
description. This section is called the Tool 
Tip Field.
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2. Right-click the form field, click Properties from the drop-down. A Text Field 
Properties dialog box will open. Select General, locate Tool Tip field, type a 
description of the form field, and close when finished.

To fix:

1.  In Accessibility Checker panel, right-click Figures Alternate Text and click Fix 
from the drop-down.

2.  A Set Alternate Text dialog box will open. Type a description of the highlighted 
image into the Alternate Text field. Repeat steps until all images have an alternate 
text, then click Save & Close. 

NOTE: If the image is solely used for aesthetic purposes, check the Decorative 
Figure box.

Figures Alternate Text

You must make sure that images in the 
document has an alternate text for screen 
readers to describe images to the listener.
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To fix:

1.  In Accessibility Checker panel, click under Nested Alternate Text and identify the 
highlight failed content.

2. After identifying the element, click Reading Order in the panel to the right.

3. A Reading Order dialog box will open, you will noticed that the buttons are 
unclickable. Drag box, to the side of your screen so that the document is viewable.

4. Drag and draw a rectangle over the highlighted figure with the nested alternate 
text. Make sure to include the entire element within the drawn rectangle. 

Nested Alternate Text

This issue comes from having an alternate 
text within an image that already contains 
an alternate text. Screen readers aren’t 
able to read the alternate text for nested 
elements. Therefore, don’t apply alternate 
text to nested elements.
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5. The buttons within the Reading Order dialog box will become avaliable. Click 
Figure.

6. The elements will become a single figure and an alternate text needs to be 
added. Right-click within the figure box and click, Edit Alternate Text from the drop 
down and an Alternate Text dialog box will appear. Manually type out an accurate 
description of the figure then click OK.

7. Repeat steps 4-6 until all nested alternate texts are removed.
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To Fix:

1. In Accessibility Checker panel, left-click Associated with Content to decollaspe 
the list of failed elements. Right-click Element 1, click Show in Tags Panel from the 
drop-down and then the Tags Panel will automatically highlight the failed element.

2. Right-click the highlighted element and click Delete Tag from the drop-down. 
Repeat steps 1-2 until all failed element tags have been removed.

Hidden annotations within an element are alternate texts that are hidden under 
another alternate text. Fix the failure by removing the alternate text from parent (top) 
element. If the alternate text in the parent element is needed, drag the object with of 
the sibling (sub) tag so that it becomes it’s own parent (top) tag.

To Fix:

1. In Accessibility Checker panel, left-click Hides Annotation to decollaspe the list 
of failed hidden annotation element. Right-click Element 1, click Show in Tags Panel 
from the drop-down and then the Tags Panel will automatically highlight the failed 
element.

NOTE: If element has no tag, click Show in Content Panel, right-click highlighted 
content, then click Show in Tag Panel.

Associated with Content

You must make sure that alternate text 
is always an alternate representation for 
content on the page. If an element has 
alternate text but does not contain any 
page content, there is no way to determine 
which page it is on.

Hidden Annotation

Alternate text can’t hide an annotation. If 
an annotation is nested under a parent 
element with alternate text, then screen 
readers cannot see it.
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NOTE: If element still shows no tag within selection, refer to the section on Tagged 
Annotation, to create a tag for the failed annotation element.

2. The tag structure may vary in complexity. Identify the tag with the alternate text 
that is hiding an annotation tag within the parent tag.

3. In the Tags Panel, right-click and drag the hidden annotation tag from within the 
parent tag, to below the parent tag so that it now becomes its own parent tag.

4. Close the dialog box and return to the failed Hides Annotation list in Accessibility 
Checker. Right click Hides Annotation > Check Again from the drop-down. 

PARENT figure tag

Tag w/ alternate text

HIDDEN annotation tag

Annotation

PARENT figure tag

Tag w/ alternate text

PARENT annotation tag

Annotation

Since this section searches for content other than figures, there are various ways 
to fix the failed elements. In most cases, the failed element is an invisible figure box 
over a group of text such as an empty text box or a square outline with no stroke or 
fill color. These invisible boxes typically comes from the original program when the 
author fails to delete the excess box.

To Fix:

1. Click Edit PDF under the Tools tab, click the invisible box and delete.

2. In the Accessibility Checker, right click Other Elements Alternate Text, then click 
Check Again from the drop-down.

Other Elements Alternate Text

This report checks for content, other than 
figures, that requires alternate text (such 
as multimedia, annotation, or 3D model). 
You must make sure that alternate text 
is always an alternate representation for 
content on the page. If an element has 
alternate text but does not contain any 
page content, there is no way to determine 
which page it is on.
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In other cases, the failed element needs to be tagged as a figure and add the 
alternate text manually.

To Fix:

1. In Accessibility Checker panel, left-click Other Elements Alternate Text to 
decollaspe the list of failed elements. Right-click Element 1, click Show in Tags Panel 
from the drop-down and then the Tags Panel will automatically highlight the failed 
element.

NOTE: If the element does not have a tag, click Show in Content Panel. The Content 
Panel will automatically highlight the failed element.

2. Identify the highlight content, select Reading Order in the right panel. A Reading 
Order dialog box will open, you will noticed that the buttons are unclickable. Drag 
box, to the side so that the document is viewable.

3. Drag and draw a rectangle over the highlighted element. The buttons within the 
Reading Order dialog box will become avaliable and click, Figure.
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Use the Reading Order tool to make sure that tables are tagged correctly. If you 
need to structure figures and text within the cells of your table, we highly suggest to 
re-create the table in the authoring application before you convert it to an accessible 
PDF. Adding tags on a cell level in Acrobat is a labor-intensive procedure.

To Fix:

1. In Accessibility Checker panel, left-click Rows to decollaspe the list of failed 
elements. Right-click Element 1, click Show in Tags Panel from the drop-down and 
then the Tags Panel will automatically highlight the failed element.

4. The element will become a single figure and an alternate text needs to be 
added. Right-click within the figure box and click, Edit Alternate Text from the drop 
down and an Alternate Text dialog box will appear. Manually type out an accurate 
description of the figure then click OK.

NOTE: If you do not see the Edit Alternate Text... in the drop down, redraw the box 
around the element, right click and choose Delete Selected Item Stucture from the 
drop down. Repeat step 3-4 to recreate the tag and add an alternate text.

Rows

This rule checks whether each TRow in a 
table is a child of Table, THead, TBody, or 
TFoot (See standard tag PDF section for 
tag definitions).
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2. Identify  the <TR> element that is not a child tag of a <table> element. In order to 
correct the structure, a <TR> must be placed with in a <table> element. Click and drag 
the stray <TR> below the <table> element.

NOTE: While dragging the tag, an underline will appear and follow your cursor within 
the Tags Panel to indicate where you are dragging within the tag structure. The line 
length will indicate whether you are placing the tag has a Parent, Child or Sibling tag.

3. Return the Accessibility Checker, right click Rows, then click Check Again from 
the drop-down. Repeat steps 1-2 until all failed elements has been fixed.

Child tag of <table> ALSO parent tag of <Span>

Parent tag

Sibling tag

Child tag of <Span> ALSO sibling tags of <Span>

To Fix:

1. In Accessibility Checker panel, left-click TH and TD to decollaspe the list of failed 
hidden annotation element. Right-click Element 1, click Show in Tags Panel from the 
drop-down and then the Tags Panel will automatically highlight the failed element.

TH and TD

In a proper table structure, TH and TD 
are children of TR. This check fails when 
a TH or TD is not nested under a TR 
(See standard tag PDF section for tag 
definitions).
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2. Identify the <TD> or <TH> element that is not a child tag of a <TR> element. In 
order to correct the structure,  the <TD> or <TH> must be placed with in a <TR> 
element. Click and drag the stray <TD> or <TH> below the <TR> element.

3. Return the Accessibility Checker, right click TH and TD, then click Check Again 
from the drop-down. Repeat steps 1-2 until all failed elements has been fixed.

To Fix:

1. In Accessibility Checker panel, left-click Headers to decollaspe the list of failed 
hidden annotation element. Right-click Element 1, click Show in Tags Panel from the 
drop-down and then the Tags Panel will automatically highlight the failed element.

2. Identify the table row that needs the <TD> to be changed to <TH>.

Headers

For accessibility, it’s necessary that all 
tables in the PDF have a header. To pass 
this check, ensure that all tables contain 
table header cells (See standard tag PDF 
section for tag definitions). 

decollapsecollapsed
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3. Show the table tags by clicking the Reading Order tool, right-clicking the table and 
selecting Table Editor.

4. After you have identified which table row of <TD> tags need to be changed, open 
the Tags panel and return to the failed element. Double click the first <TD> and 
manually change the tag to <TH>.

5. Repeat steps 1-4 until all failed elements has been fixed.
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To Fix:

1. In Accessibility Checker panel, left-click Regularity to decollaspe the list of failed 
hidden annotation element. Right-click Element 1, click Show in Tags Panel from the 
drop-down and then the Tags Panel will automatically highlight the failed element.

2. In the Tags Panel panel, decollaspe the highlighted failed <table> element to 
identifiy the irregular number of rows or columns.

NOTE: This table example was created in Microsoft Word and exported with Create 
PDF feature under the Adobe tab. Notice that row 5 & 7 span the width of two 
columns. This property must be manually specified within the Table Cell Properties. 

Regularity

To be accessible, tables must contain the 
same number of columns in each row, and 
rows in each column. You must ensure 
that each table row has the same number 
of columns or the ColSpan and RowSpan 
properties of a cell are set properly to 
account for all cells in a row.

decollapse collapsed

2 columns

2 columns

2 columns

3 columns

table sample

2 columns

2 columns

2 columns

3 columns
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3. Show the table tags by clicking the Reading Order tool, right-clicking the table and 
selecting Table Editor.
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4. Right-click the table and select Table Editor Options. A Table Editor Options 
dialog box will open and show the meaning of the colored cells. 

5. Identify which cells need to span multiple rows/column, then select the cell so that 
a light blue outline appears.

6. Right-click the outlined cell and select Table Cell Properties. A Table Cell 
Properties dialog box will open and show the cell type and attributes. 

7. Below the Attribute section, indicate how many rows or columns the selected cell 
spans then click OK. The change may or may no cause the cell to change color.

8. After clicking OK, you may get a message stating that the cell change may cause 
a malfunction in viewing the table. Disregard this message, continue steps 5-7 until 
the table passes the regularity check and all columns and rows are indicated to its 
appropriate span.

spans 2 columns
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Provide a table summary for data tables where it is needed to make the data easier 
to understand, or to provide instructions on the data reviewed.

To Fix: 

1. In Accessibility Checker panel, left-click Summary to decollaspe the list of failed 
hidden annotation element. Right-click Element 1, click Show in Tags Panel from the 
drop-down and then the Tags Panel will automatically highlight the failed element.

2. On the right panel, select the Reading Order tool. A Reading Order dialog box will 
open and you will noticed that the buttons are unclickable.

Summary

Table summaries are optional unless 
the table data cannot be understood by 
the accessibility reader. Summaries can 
improve accessibility in complex data 
tables or when the way in which the data is 
read may be important.
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Depending on the software used to create or export the PDF (such as exporting from 
Microsoft Words), some list structure will not be utilizing the label element tag <Lbl>. 
Adobe InDesign CC will export with the <Lbl> tag to define bullet point, numbers, 
and etc. Either structure will pass the check as long as they remain in the appropriate 
order.

3. Right-click the table and select Edit Table Summary. A Table Summary dialog box 
will open, type a description or summary about the table then click OK. Repeat steps 
1-3 until all tables have a summary and pass the acessibility check.

List  I tems

The check reports whether each List Item 
(LI) is a child of List (L). When this check 
fails, a Ll tag is out of order within the 
stucture. Lists must have the following 
structure: A List element must contain List 
Item Elements. List Item Elements can only 
contain Label Elements (Lbl) and List Item 
Body Elements (LBody).  

list item element

list element

list item body element
no <Lbl> , bullet point 
part of item tag

Exported from
Microsoft Word

list item element

list elementExported from
InDesign CC

bullet point is tagged 
seperately

list item body element

label element

Original List
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Please refer to the section on List Items for the correct order of a list structure. 

To Fix: 

1. In Accessibility Checker panel, decollaspe the Lbl and LBody section to view the 
failed elements. Right-click Lbl/LBody 1 > Show in Tags Panel. The Tags Panel will 
automatically highlight the failed element.

To Fix:

In Accessibility Checker panel, decollaspe the List Items section to view the 
failed elements. Right-click Element 1 > Show in Tags Panel. The Tags Panel will 
automatically highlight the failed element.

2. Identify the highlighted element and how it is misplaced. In this example, the 
<LI> tag is not in the correct order. <LI> is a child element of a <L> tag and must be 
manually dragged to be reposition within the <L> tag.

3. Repeat steps 1-2 to restructure misplaced list elements. If this check continues 
to fail, it is highly recommended to recreate  the document or simplify the list in its 
original file prior to exporting it as a PDF.

Lbl  and LBody 

When this check fails, the list structure is 
not in appropriate order due to a misplaced 
Lbl or LBody tag. 
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2. The highlighted element indicates the Lbl or LBody tag that is out of order. Refer to 
the correct list order and determine where the misplaced tag should be repositioned.

3. Manually drag <LBody> tag below a <LI> tag. If there is a <Lbl> tag present, make 
sure <LBody> is placed after <Lbl>.

4. Repeat steps until all the misplaced tags has been appropriately repositioned. If 
this check continues to fail, it is highly recommended to recreate the document or 
simplify the list in its original file prior to exporting it as a PDF.

list item

list

list item body

Example of Correct OrderIncorrect Order

Before After
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Headers must be in a linear descending order inline such as H1, H2, H3, and does 
not skip or ascend in order. However headers can be repeated as long as the order 
does not ascend, such as H1, H2, H2, H3.

Headers must also be in linear descending order when pertaining to parent and child 
tags. For example, a H3 header must be a child of H2. 

To Fix:

In Accessibility Checker panel, decollaspe the Appropriate Nesting section to view 
the failed elements. Right-click Element 1 > Show in Tags Panel. The Tags Panel will 
automatically highlight the failed element.

Appropriate Nesting

This rule checks nested headings. When 
this check fails, headings are not nested 
properly.

parent and 
child

inline
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2. Identify the highlighted element and how the heading tag is not in its appropriate 
order. 

3. Change the heading tag to its appropriate order. In the Tags Panel, double-click 
tag and type in correct tag.
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https://helpx.adobe.com/acrobat/using/create-verify-pdf-accessibility.html

https://helpx.adobe.com/acrobat/using/reading-pdfs-reflow-accessibility-features.html

https://www.adobe.com/accessibility/products/acrobat/using-acrobat-pro-
accessibility-checker.html

https://helpx.adobe.com/acrobat/user-guide.html?topic=/acrobat/morehelp/
accessibility_tags_and_reflow.ug.js

https://www.adobe.com/accessibility/products/acrobat/pdf-repair-repair-tables.html

https://www.adobe.com/accessibility/products/acrobat/pdf-repair-repair-tags-
advanced.html

https://forums.adobe.com/thread/1270583

https://www.w3.org/TR/WCAG20-TECHS/PDF6.html#PDF6-examples

https://www.w3.org/Consortium/mission

https://www.w3.org/standards/

https://www.w3.org/WAI/GL/WCAG-PDF-TECHS/Overview.html

https://www.w3.org/TR/WCAG20-TECHS/PDF21.html

https://www.w3.org/TR/WCAG21/

Resources

Information and content has been collected  
rephrased from these links. All credits for 
copied content goes to the rightful owner 
of these web pages. All screenshots and 
images are original. 
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	accessible PDFs. If you do not have the 
	paid version of the program, you will not be 
	able to access the tools that can make ADA 
	complaint doucments. 


	Acrobat Pro DC or as part of the Adobe Creative Cloud subscription are version 
	Acrobat Pro DC or as part of the Adobe Creative Cloud subscription are version 
	Acrobat Pro DC or as part of the Adobe Creative Cloud subscription are version 
	that has the tools to create and validate PDFs to meet accessbility requirements for 
	people with disabilities. 

	DO NOT BUY ACROBAT STANDARD DC. Although this is a paid version of Acrobat, 
	DO NOT BUY ACROBAT STANDARD DC. Although this is a paid version of Acrobat, 
	this version does not have the tools for accessibilty as well as the capabiltiy to turn 
	scanned documents into editable and searchable PDFs. 

	Adobe Reader DC is the free program that only allows people to view, print, and 
	Adobe Reader DC is the free program that only allows people to view, print, and 
	annotate PDFs. You cannot create a PDF, export, set security parameters, or make 
	PDFs accessibility standard compliant.


	Accessibility Workspace
	Accessibility Workspace
	Accessibility Workspace

	Use the Accessibility Full Check command 
	Use the Accessibility Full Check command 
	to perform a thorough check for many 
	characteristics of accessible PDFs, such 
	as the use of alternative text on images, 
	the presence of tags, document language, 
	and fonts that can be mapped reliably to 
	Unicode text.

	It is possible to choose which kinds of 
	It is possible to choose which kinds of 
	accessibility issues to look for in Full Check 
	by using the Accessibility Checker Options. 
	There are also options to view and save 
	the results. 


	Left Panel
	Left Panel
	Left Panel


	Figure
	Page Thumbnails
	Page Thumbnails
	Page Thumbnails


	Bookmarks
	Bookmarks
	Bookmarks


	Accessibility Checker
	Accessibility Checker
	Accessibility Checker


	Attachments
	Attachments
	Attachments


	Content Panel
	Content Panel
	Content Panel


	Order
	Order
	Order


	Tag Panel
	Tag Panel
	Tag Panel


	Model Tree
	Model Tree
	Model Tree


	Right Panel
	Right Panel
	Right Panel


	Figure
	Accessibility Tools
	Accessibility Tools
	Accessibility Tools


	Accessibility Checker 
	Accessibility Checker 
	Accessibility Checker 

	Use Full Check command under the 
	Use Full Check command under the 
	Accessibility Tool, to perform a thorough 
	check for many characteristics of 
	accessible PDFs, such as the use of 
	alternative text on images, the presence of 
	tags, document language, and fonts that 
	can be mapped reliably to Unicode text.

	It is possible to choose which kinds of 
	It is possible to choose which kinds of 
	accessibility issues to look for in Full Check 
	by using the Accessibility Checker Option. 
	There are also options to view and save 
	the results. 


	To run the Accessibility Full Check:
	To run the Accessibility Full Check:
	To run the Accessibility Full Check:

	1.  Under the 
	1.  Under the 
	Tools
	 tab, select 
	Accessibility
	.

	2. On the right side panel, select 
	2. On the right side panel, select 
	Full Check
	.

	3. An 
	3. An 
	Acessibility Checker Options 
	dialog box will open. Make sure the 
	Page Range
	 
	is set to 
	All pages in document
	 and that all the checkboxes under 
	Checking Options
	 
	are selected, then click 
	Start Checking
	.


	Figure
	Figure
	Figure
	Figure
	4.  After the check is complete, the results are displayed via the Accessibility Checker 
	4.  After the check is complete, the results are displayed via the Accessibility Checker 
	4.  After the check is complete, the results are displayed via the Accessibility Checker 
	panel.

	Accessibility Checker Panel
	Accessibility Checker Panel

	Once a report has been run, the issues that have been found are displayed in the 
	Once a report has been run, the issues that have been found are displayed in the 
	Accessibility Checker panel. The results tree displays one of the following states for 
	each rule check (See “Figure 6. Accessibility Rule Check State”).

	Passed:
	Passed:
	   The item passed this accessible check.

	Passed Manually:  
	Passed Manually:  
	 The item was marked passed by manual inspect.

	Skipped By User: 
	Skipped By User: 
	  The rule was not selected in the Accessibility Checker 

	   Options dialog box.
	   Options dialog box.

	Needs Manual Check: 
	Needs Manual Check: 
	 The Full Check feature could not check the item 

	   automatically. Verify the item manually.
	   automatically. Verify the item manually.

	Failed: 
	Failed: 
	   The item did not pass the accessibility check.


	Figure
	Figure
	Figure
	Figure
	Figure
	Figure
	Standard PDF Tags
	Standard PDF Tags
	Standard PDF Tags

	This section describes the standard tag types that apply to tagged PDFs. These standard tags provide assistive software and devices 
	This section describes the standard tag types that apply to tagged PDFs. These standard tags provide assistive software and devices 
	with semantic and structural elements to use to interpret document structure and present content in a useful manner.

	The PDF tags architecture is extensible, so any PDF document can contain any tag set that an authoring application decides to use. In 
	The PDF tags architecture is extensible, so any PDF document can contain any tag set that an authoring application decides to use. In 
	other words, the software that the original document was created in defines the standard tags applied within the file. For example, a PDF 
	can have XML tags that came in from an XML schema. However, additional information is often neccesary for accurate notation. 

	Custom tags that you define (such as tag names generated from paragraph styles of an authoring application) need a role map. The role 
	Custom tags that you define (such as tag names generated from paragraph styles of an authoring application) need a role map. The role 
	map matches each custom tag to a standard tag here. When assistive software encounters a custom tag, the software can check this role 
	map and properly interpret the tags. 

	Tagging PDFs by using one of the methods described here generally produces a correct role map for the document.
	Tagging PDFs by using one of the methods described here generally produces a correct role map for the document.


	Container Elements
	Container Elements
	Container Elements

	Container elements are the highest level of element and provide hierarchical grouping for other block-level elements.
	Container elements are the highest level of element and provide hierarchical grouping for other block-level elements.

	Document 
	Document 
	  Document element. The root element of a document’s tag tree.

	Part  
	Part  
	  Part element. A large division of a document; may group smaller units of content together, such as division   
	   elements, article elements, or section elements.

	Div 
	Div 
	   Division element. A generic block-level element or group of block-level elements.

	Art
	Art
	   Article element. A self-contained body of text considered to be a single narrative.

	Sect
	Sect
	   Section element. A general container element type, comparable to Division (DIV Class=“Sect”) in HTML, which 

	   is usually a component of a part element or an article element.
	   is usually a component of a part element or an article element.

	Heading And Paragraph Elements
	Heading And Paragraph Elements

	Heading and paragraph elements are paragraph-like, block-level elements that include specific level heading and generic paragraph (P) 
	Heading and paragraph elements are paragraph-like, block-level elements that include specific level heading and generic paragraph (P) 
	tags. A heading (H) element should appear as the first child of any higher-level division. Six levels of headings (H1 to H6) are available for 
	applications that don’t hierarchically nest sections.

	Label and List Elements
	Label and List Elements

	Label and list elements are block-level elements used for structuring lists.
	Label and list elements are block-level elements used for structuring lists.

	L
	L
	   List element. Any sequence of items of similar meaning or other relevance; immediate child elements should   
	   be list item elements.

	Ll 
	Ll 
	  List item element. Any one member of a list; may have a label element (optional) and a list body element  

	   (required) as a child.
	   (required) as a child.

	LBL
	LBL
	   Label element. A bullet, name, or number that identifies an element from others in the same list.

	LBody
	LBody
	   List item body element. The descriptive content of a list item.


	Special Text Elements
	Special Text Elements
	Special Text Elements

	Special text elements identify text that isn’t used as a generic paragraph (P).
	Special text elements identify text that isn’t used as a generic paragraph (P).

	BlockQuote 
	BlockQuote 
	  One or more paragraphs attributed to someone other than the author of the immediate surrounding text.

	Caption  
	Caption  
	  Caption element. A brief portion of text that describes a table or a figure.

	Index
	Index
	   Index element. A sequence of entries that contain identifying text and reference elements that point out the 

	   occurrence of the text in the main body of the document.
	   occurrence of the text in the main body of the document.

	TOC
	TOC
	   Table of contents element. An element that contains a structured list of items and labels.

	TOCI
	TOCI
	   Table of contents item element. An item contained in a list associated with a table of contents element.

	Table Elements
	Table Elements

	Table elements are special elements for structuring tables.
	Table elements are special elements for structuring tables.

	Table
	Table
	   A two-dimensional arrangement of data or text cells that contains table row elements as child 

	   elements and may have a caption element as its first or last child element.
	   elements and may have a caption element as its first or last child element.

	TR 
	TR 
	  One row of headings or data in a table; may contain table header cell elements and table data cell elements.

	TD
	TD
	   Table data cell element. A table cell that contains nonheader data.

	TH
	TH
	   A table cell that contains header text or data describing one or more rows or columns of a table.

	Inline-Level Elements
	Inline-Level Elements

	Inline-level elements identify a span of text that has specific formatting or behavior. They are differentiated from block-level elements.
	Inline-level elements identify a span of text that has specific formatting or behavior. They are differentiated from block-level elements.

	BibEntry
	BibEntry
	   Bibliography entry element. A description of where some cited information may be found.

	Quote 
	Quote 
	  Quote entry element. An inline portion of text that is attributed to someone other than the author of the text 

	   surrounding it.
	   surrounding it.

	Span
	Span
	   Span entry element. Any inline segment of text; commonly used to delimit text that is associated with a set of 

	   styling properties.
	   styling properties.

	Special Inline-Level Elements
	Special Inline-Level Elements

	Similar to inline-level elements, special inline-level elements describe an inline portion of text that has special formatting or behavior.
	Similar to inline-level elements, special inline-level elements describe an inline portion of text that has special formatting or behavior.

	Figure
	Figure
	   Figure entry element. A graphic or graphic representation associated with text.

	Form 
	Form 
	  Form entry element. A PDF form annotation that can be or has been filled out.

	Formula 
	Formula 
	  Formula entry element. A mathematical formula.

	Link
	Link
	   Link entry element. A hyperlink that is embedded within a document. The target can be in the same 

	   document, in another PDF document, or on a website.
	   document, in another PDF document, or on a website.

	Note
	Note
	   Note entry element. Explanatory text or documentation, such as a footnote or endnote, that is referred to in 

	   the main body of text.
	   the main body of text.

	Reference
	Reference
	  Reference entry element. A citation to text or data that is found elsewhere in the document.


	Accessibility Permission Flag
	Accessibility Permission Flag
	Accessibility Permission Flag

	A document author can specify that 
	A document author can specify that 
	no part of an accessible PDF is to be 
	copied, printed, extracted, commented 
	on, or edited. This setting could interfere 
	with a screen reader’s ability to read the 
	document, because screen readers must 
	be able to copy or extract the document’s 
	text to convert it to speech.


	If the report shows that this section failed, it is required that you turn on the security 
	If the report shows that this section failed, it is required that you turn on the security 
	If the report shows that this section failed, it is required that you turn on the security 
	settings that will allow accessibility.

	To fix:
	To fix:

	1.  Go to 
	1.  Go to 
	File
	 > 
	Properties
	 > 
	Security

	2. Under the Document Security section, select No Security from the drop-down.
	2. Under the Document Security section, select No Security from the drop-down.


	Figure
	Image-Only PDF
	Image-Only PDF
	Image-Only PDF

	Reports whether the document contains 
	Reports whether the document contains 
	non-text content that is not accessible. If 
	the document appears to contain text, but 
	doesn’t contain fonts, it could be an image-
	only PDF file.


	Scanned documents most often appear as image-only PDFs. We do not recommend 
	Scanned documents most often appear as image-only PDFs. We do not recommend 
	Scanned documents most often appear as image-only PDFs. We do not recommend 
	scanning documents as a method to generate PDFs.  Although there is a possible fix, 
	it is extremely inaccurate unless the text is minimal. Creating a PDF from the original 
	file is highly recommended and the easier approach to fixing this issue. However, you 
	may attempt to manually fix this rule through scanning the document for recognizable 
	text. Some aesthetic alteration in the letters and words may result.

	To fix:
	To fix:

	1.  Go to 
	1.  Go to 
	Tools
	 > 
	Enchanced Scans

	2. On the taskbar above, click 
	2. On the taskbar above, click 
	Recognize Text
	 > 
	In This File
	 > 
	Recognize Text (bold)


	Figure
	Figure
	Tagged PDF
	Tagged PDF
	Tagged PDF

	If this rule check fails, the document isn’t 
	If this rule check fails, the document isn’t 
	tagged to specify the correct reading order.


	Checking if the PDF is tagged should be the first thing you should immediately try to 
	Checking if the PDF is tagged should be the first thing you should immediately try to 
	Checking if the PDF is tagged should be the first thing you should immediately try to 
	fix because it may automatically fix other tagging-related issue within the file. 

	To fix:
	To fix:

	1.  In 
	1.  In 
	Accessibility Checker
	 panel, right click 
	Tagged PDF
	 and click 
	Fix
	 from the drop-
	down. Acrobat automatically adds tags to the PDF.


	Figure
	Logical Reading Order
	Logical Reading Order
	Logical Reading Order

	Verify this rule check manually. Make sure 
	Verify this rule check manually. Make sure 
	that the reading order displayed in the Tags 
	panel coincides with the logical reading 
	order of the document.


	The full check feature is not capable of verifying the reading order automatically; 
	The full check feature is not capable of verifying the reading order automatically; 
	The full check feature is not capable of verifying the reading order automatically; 
	therefore, a manual check over the document’s reading order is required. In the 
	event that changes are needed within the reading order, open the Order panel 
	and drag contents within the list. If the Order panel icon does not show, right-click 
	anywhere on the left sidebar. A drop-down list will open, select Order Panel.


	Figure
	Primary Language
	Primary Language
	Primary Language

	Setting the document language in a PDF 
	Setting the document language in a PDF 
	enables some screen readers to switch 
	to the appropriate language. This check 
	determines whether the primary text 
	language for the PDF is specified. If the 
	check fails, set the language.


	To fix:
	To fix:
	To fix:

	1.  In 
	1.  In 
	Accessibility Checker
	 panel, right-click 
	Primary Language
	 and click 
	Fix
	 from 
	the drop-down. 

	2. A pop-up box called, 
	2. A pop-up box called, 
	Set Reading Language
	 will appear, select the appropriate 
	language for the document and then click 
	OK
	.


	Figure
	Figure
	Title
	Title
	Title

	Reports whether there is a title in the 
	Reports whether there is a title in the 
	Acrobat application title bar.


	To fix:
	To fix:
	To fix:

	1.  In 
	1.  In 
	Accessibility Checker
	 panel, right-click 
	Title
	 and click 
	Fix
	 from the drop-down. 
	In some instances, Acrobat will automatically fix the title. 

	2. If this doesn’t occur, a 
	2. If this doesn’t occur, a 
	Description
	 dialog box will appear. Uncheck 
	Leave As Is
	, 
	below the 
	Title
	 field and type the correct title, and click 
	OK
	.


	Figure
	Bookmarks
	Bookmarks
	Bookmarks

	A fail in bookmarks occurs when a 
	A fail in bookmarks occurs when a 
	document has 21 or more pages, but 
	doesn’t have bookmarks that parallel the 
	document structure.


	To fix:
	To fix:
	To fix:

	1.  In 
	1.  In 
	Accessibility Checker
	 panel, right-click 
	Bookmarks
	 and click 
	Fix
	 from the drop-
	down.

	2. In the 
	2. In the 
	Structure Elements
	 dialog box, select the elements you want to use as 
	bookmarks, and click 
	OK
	.


	Figure
	Color Contrast
	Color Contrast
	Color Contrast

	When a color contrast check fails, it’s 
	When a color contrast check fails, it’s 
	possible that the document contains 
	content that isn’t accessible to people who 
	are color-blind.


	This section is a manual fix and must adhere to the guidelines in WCAG section 1.4.3 
	This section is a manual fix and must adhere to the guidelines in WCAG section 1.4.3 
	This section is a manual fix and must adhere to the guidelines in WCAG section 1.4.3 
	or include a recommendation in the PDF viewer to use high-contrast color.

	To fix:
	To fix:

	1.  In 
	1.  In 
	Edit
	, click 
	Preference
	 (Windows) or in 
	Acrobat
	, click 
	Preferences
	 (Mac).

	2. 
	2. 
	Accessibility
	 > uncheck 
	Replace Document Colors
	 > select 
	Use High-Contrast 
	Colors
	. Choose a color combination from the drop-down, then click 
	OK
	.


	Figure
	Figure
	Tagged Content
	Tagged Content
	Tagged Content

	A tagged content check reports whether 
	A tagged content check reports whether 
	all content in the document is tagged. 
	You must make sure that all content in the 
	document is either included in the Tags 
	tree, or marked as an artifact.


	To fix:
	To fix:
	To fix:

	1.  In 
	1.  In 
	Accessibility Checker
	 panel, left-click 
	Tagged Content
	 to decollaspe the list of 
	elements.

	2. Right-click 
	2. Right-click 
	Element 1
	, click 
	Show in Content Panel 
	from the drop-down.

	3. In the Content Panel, locate the highlighted content and right-click > 
	3. In the Content Panel, locate the highlighted content and right-click > 
	Create 
	Artitifact
	 from drop-down. 

	4. In the 
	4. In the 
	Create Artifact
	 dialog box, select the appropriate 
	Artifact Type
	, then click 
	OK
	. Repeat Step 1-4 until all elements are tagged.
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	Figure
	Figure
	Tagged Annotations
	Tagged Annotations
	Tagged Annotations

	This rule checks whether all annotations 
	This rule checks whether all annotations 
	are tagged. Make sure that annotations 
	such as comments and editorial marks 
	(such as insert and highlight) are either 
	included in the Tags tree or marked as 
	artifacts.


	To fix:
	To fix:
	To fix:

	1. In 
	1. In 
	Accessibility Checker
	 panel, left-click 
	Tagged Annotations
	 to decollaspe the list 
	of failed elements. Right-click 
	Element 1
	, click 
	Show in Content Panel 
	from the drop-
	down and then the Content Panel will automatically highlight the failed element. 

	2. Once you have indentified the highlighted untagged content, click the option icon, 
	2. Once you have indentified the highlighted untagged content, click the option icon, 
	and select 
	Find 
	in the drop-down.

	3. A 
	3. A 
	Find Elements
	 dialog box will open. Select 
	Unmarked Annotations
	 from the 
	drop-down. Click the 
	Search Page
	 circle > 
	Find
	.

	NOTE: Your selection for within the Find drop-down menu should be determined by 
	NOTE: Your selection for within the Find drop-down menu should be determined by 
	what you think is best used to appropriately tag the content.

	4. The 
	4. The 
	Type
	 that will appear in the dialog box are the untagged annotation within the 
	Page. Select 
	Tag Element
	, for the untagged content item.

	4. A 
	4. A 
	New Tag
	 dialog box will appear. Select the appropriate type drop-down > 
	OK
	. 
	In 
	Find Element
	 dialog box, click 
	Find Next
	. Repeat steps 3-4 until all unmarked 
	annotations have been tagged.
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	Figure
	Figure
	Figure
	Figure
	Figure
	Tab Order
	Tab Order
	Tab Order

	Because tabs are often used to navigate 
	Because tabs are often used to navigate 
	a PDF, it’s necessary that the tab order 
	parallels the document structure.


	To fix:
	To fix:
	To fix:

	1.  In 
	1.  In 
	Accessibility Checker
	 panel, right click 
	Tab Order
	 and click 
	Fix
	 from the drop-
	down. Acrobat will automatically fix the tab order.


	Figure
	Character Encoding
	Character Encoding
	Character Encoding

	Specifying the encoding helps PDF viewers’ 
	Specifying the encoding helps PDF viewers’ 
	present users with readable text. Most 
	character-encoding issues aren’t repairable 
	within Acrobat.


	To ensure proper encoding, do the following:
	To ensure proper encoding, do the following:
	To ensure proper encoding, do the following:

	• Verify that the necessary fonts are installed on your system.
	• Verify that the necessary fonts are installed on your system.

	• In the original document, change the font, and then re-create the PDF.
	• In the original document, change the font, and then re-create the PDF.

	• Re-create the PDF file with a newer version of Acrobat Distiller.
	• Re-create the PDF file with a newer version of Acrobat Distiller.


	Tagged Multimedia
	Tagged Multimedia
	Tagged Multimedia

	The tagged multimedia checks whether all 
	The tagged multimedia checks whether all 
	multimedia objects are tagged. Make sure 
	that content is either included in the Tags 
	tree or marked as an artifact.


	To fix:
	To fix:
	To fix:

	1.  In 
	1.  In 
	Accessibility Checker
	 panel, left-click 
	Tagged Multimedia
	 to decollaspe the list 
	of elements. Right-click 
	Element 1
	, click 
	Show in Content Panel 
	from the drop-down.

	2. In the Content Panel, locate the highlighted content and right-click > 
	2. In the Content Panel, locate the highlighted content and right-click > 
	Create 
	Artitifact
	 from drop-down. 

	3. In the 
	3. In the 
	Create Artifact
	 dialog box, select appropriate 
	Artifact Type
	, click 
	OK
	. 
	Repeat Step 1-4 until all elements are tagged.
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	Figure
	Figure
	Screen Flicker
	Screen Flicker
	Screen Flicker

	Elements that make the screen flicker, 
	Elements that make the screen flicker, 
	such as animations and scripts, can 
	cause seizures in individuals who have 
	photosensitive epilepsy. These elements 
	can also be difficult to see when the screen 
	is magnified.


	If the Screen Flicker rule fails, manually remove or modify the script or content that 
	If the Screen Flicker rule fails, manually remove or modify the script or content that 
	If the Screen Flicker rule fails, manually remove or modify the script or content that 
	causes screen flicker in the original program the PDF file was created in.

	*This section of the Accessibility Checker is only applicable to interactive PDFs.
	*This section of the Accessibility Checker is only applicable to interactive PDFs.


	Scripts
	Scripts
	Scripts

	Content cannot be script-dependent 
	Content cannot be script-dependent 
	unless both content and functionality are 
	accessible to assistive technologies. Make 
	sure that scripting doesn’t interfere with 
	keyboard navigation or prevent the use of 
	any input device.


	Check the scripts manually. Remove or modify any script or content that 
	Check the scripts manually. Remove or modify any script or content that 
	Check the scripts manually. Remove or modify any script or content that 
	compromises accessibility in the original program the PDF file was created in.

	*This section of the Accessibility Checker is only applicable to interactive PDFs.
	*This section of the Accessibility Checker is only applicable to interactive PDFs.


	Timed Responses
	Timed Responses
	Timed Responses

	This rule check applies to documents that 
	This rule check applies to documents that 
	contain forms with JavaScript. If the rule 
	check fails, make sure that the page does 
	not require timed responses. Edit or remove 
	scripts that impose timely user response so 
	that users have enough time to read and 
	use the content.


	Manually edit or remove scripts that impose timely user response so that users have 
	Manually edit or remove scripts that impose timely user response so that users have 
	Manually edit or remove scripts that impose timely user response so that users have 
	enough time to read and use the content. The scripts can be modified in the original 
	program the PDF file was created in.

	*This section of the Accessibility Checker is only applicable to interactive PDFs.
	*This section of the Accessibility Checker is only applicable to interactive PDFs.


	Navigation Links
	Navigation Links
	Navigation Links

	For URLs to be accessible to screen 
	For URLs to be accessible to screen 
	readers, they must be active links that are 
	correctly tagged in the PDF. 


	If this failure occurs, check navigation links manually and verify that the content does 
	If this failure occurs, check navigation links manually and verify that the content does 
	If this failure occurs, check navigation links manually and verify that the content does 
	not have more than two identical links. Also, provide a way for users to skip over 
	URLs that appear multiple times.

	*This section of the Accessibility Checker is only applicable to PDFs with hyperlinks.
	*This section of the Accessibility Checker is only applicable to PDFs with hyperlinks.


	Tagged Form Fields
	Tagged Form Fields
	Tagged Form Fields

	In an accessible PDF, all form fields are 
	In an accessible PDF, all form fields are 
	tagged and are a part of the document 
	structure. In addition, you can use the tool 
	tip form field property to provide the user 
	with information or to provide instructions.


	To Fix:
	To Fix:
	To Fix:

	1.  On the right panel, select 
	1.  On the right panel, select 
	Autotag Form Fields. 
	Acrobat automatically adds tags to 
	the form fields.


	Figure
	If the previous fix did not work, the element must be manually tagged.
	If the previous fix did not work, the element must be manually tagged.
	If the previous fix did not work, the element must be manually tagged.

	1.  Identify the untagged form field by clicking on the field list. Upon clicking, the 
	1.  Identify the untagged form field by clicking on the field list. Upon clicking, the 
	content will highlight within the document. 

	2. On the right panel, select 
	2. On the right panel, select 
	Reading Order. 
	A 
	Reading Order
	 dialog box will open, 
	you will noticed that the buttons are unclickable. Drag box, to the side of your screen 
	vvso that the document is viewable.


	Figure
	Figure
	Figure
	Figure
	Figure
	3. Drag and draw a rectangle over the form field that was highlighted. Buttons within 
	3. Drag and draw a rectangle over the form field that was highlighted. Buttons within 
	3. Drag and draw a rectangle over the form field that was highlighted. Buttons within 
	the 
	Reading Order
	 dialog box will become avaliable and click, 
	Form Field
	. 

	4. Close the dialog box and return to the failed 
	4. Close the dialog box and return to the failed 
	Tagged Form Field
	 list in 
	Accessibility Checker. 
	Right click 
	Tagged Form Field
	 > 
	Check Again 
	from the drop-
	down. 

	5. Repeat Steps 1 - 4 until the failed 
	5. Repeat Steps 1 - 4 until the failed 
	Tagged Form Field
	 list passes and a green check 
	mark shows.
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	Field Descriptions
	Field Descriptions
	Field Descriptions

	For accessibility, all form fields need a text 
	For accessibility, all form fields need a text 
	description. This section is called the Tool 
	Tip Field.


	To Fix:
	To Fix:
	To Fix:

	1.  Identify the Field by clicking on the failed field in the 
	1.  Identify the Field by clicking on the failed field in the 
	Accessibility Checker
	 and will 
	become highlighted in document. Select 
	Prepare Form
	 from the tool panel. 


	Figure
	Figure
	Figure
	2. Right-click the form field, click
	2. Right-click the form field, click
	2. Right-click the form field, click
	 Properties
	 from the drop-down. A 
	Text Field 
	Properties
	 dialog box will open. Select 
	General
	, locate 
	Tool Tip
	 field, type a 
	description of the form field, and close when finished.
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	Figures Alternate Text
	Figures Alternate Text
	Figures Alternate Text

	You must make sure that images in the 
	You must make sure that images in the 
	document has an alternate text for screen 
	readers to describe images to the listener.


	To fix:
	To fix:
	To fix:

	1.  In 
	1.  In 
	Accessibility Checker
	 panel, right-click 
	Figures Alternate Text
	 and click 
	Fix
	 
	from the drop-down.

	2.  A 
	2.  A 
	Set Alternate Text
	 dialog box will open. Type a description of the highlighted 
	image into the 
	Alternate Text 
	field. Repeat steps until all images have an alternate 
	text, then click 
	Save & Close
	. 

	NOTE: If the image is solely used for aesthetic purposes, check the 
	NOTE: If the image is solely used for aesthetic purposes, check the 
	Decorative 
	Figure
	 box.
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	Figure
	Nested Alternate Text
	Nested Alternate Text
	Nested Alternate Text

	This issue comes from having an alternate 
	This issue comes from having an alternate 
	text within an image that already contains 
	an alternate text. Screen readers aren’t 
	able to read the alternate text for nested 
	elements. Therefore, don’t apply alternate 
	text to nested elements.


	To fix:
	To fix:
	To fix:

	1.  In 
	1.  In 
	Accessibility Checker
	 panel, click under 
	Nested Alternate Text
	 and identify the 
	highlight failed content.

	2. After identifying the element, click 
	2. After identifying the element, click 
	Reading Order
	 in the panel to the right.

	3. A 
	3. A 
	Reading Order
	 dialog box will open, you will noticed that the buttons are 
	unclickable. Drag box, to the side of your screen so that the document is viewable.

	4. Drag and draw a rectangle over the highlighted figure with the nested alternate 
	4. Drag and draw a rectangle over the highlighted figure with the nested alternate 
	text. Make sure to include the entire element within the drawn rectangle. 


	Figure
	Figure
	Figure
	Figure
	5. The buttons within the 
	5. The buttons within the 
	5. The buttons within the 
	Reading Order
	 dialog box will become avaliable. Click 
	Figure.

	6. The elements will become a single figure and an alternate text needs to be 
	6. The elements will become a single figure and an alternate text needs to be 
	added. Right-click within the figure box and click, 
	Edit Alternate Text
	 from the drop 
	down and an 
	Alternate Text
	 dialog box will appear. Manually type out an accurate 
	description of the figure then click 
	OK
	.

	7. Repeat steps 4-6 until all nested alternate texts are removed.
	7. Repeat steps 4-6 until all nested alternate texts are removed.
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	Associated with Content
	Associated with Content
	Associated with Content

	You must make sure that alternate text 
	You must make sure that alternate text 
	is always an alternate representation for 
	content on the page. If an element has 
	alternate text but does not contain any 
	page content, there is no way to determine 
	which page it is on.


	To Fix:
	To Fix:
	To Fix:

	1. In 
	1. In 
	Accessibility Checker
	 panel, left-click 
	Associated with Content
	 to decollaspe 
	the list of failed elements. Right-click 
	Element 1
	, click 
	Show in Tags Panel 
	from the 
	drop-down and then the Tags Panel will automatically highlight the failed element.

	2. Right-click the highlighted element and click
	2. Right-click the highlighted element and click
	 Delete Tag 
	from the drop-down. 
	Repeat steps 1-2 until all failed element tags have been removed.
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	Hidden Annotation
	Hidden Annotation
	Hidden Annotation

	Alternate text can’t hide an annotation. If 
	Alternate text can’t hide an annotation. If 
	an annotation is nested under a parent 
	element with alternate text, then screen 
	readers cannot see it.


	Hidden annotations within an element are alternate texts that are hidden under 
	Hidden annotations within an element are alternate texts that are hidden under 
	Hidden annotations within an element are alternate texts that are hidden under 
	another alternate text. Fix the failure by removing the alternate text from parent (top) 
	element. If the alternate text in the parent element is needed, drag the object with of 
	the sibling (sub) tag so that it becomes it’s own parent (top) tag.

	To Fix:
	To Fix:

	1. In 
	1. In 
	Accessibility Checker
	 panel, left-click 
	Hides Annotation 
	to decollaspe the list 
	of failed hidden annotation element. Right-click 
	Element 1
	, click 
	Show in Tags Panel 
	from the drop-down and then the Tags Panel will automatically highlight the failed 
	element.

	NOTE: If element has no tag, click 
	NOTE: If element has no tag, click 
	Show in Content Panel
	, right-click highlighted 
	content, then click 
	Show in Tag Panel.
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	Figure
	NOTE: If element still shows no tag within selection, refer to the section on 
	NOTE: If element still shows no tag within selection, refer to the section on 
	NOTE: If element still shows no tag within selection, refer to the section on 
	Tagged 
	Annotation
	, to create a tag for the failed annotation element
	.

	2. The tag structure may vary in complexity. Identify the tag with the alternate text 
	2. The tag structure may vary in complexity. Identify the tag with the alternate text 
	that is hiding an annotation tag within the parent tag.

	3. In the Tags Panel, right-click and drag the hidden annotation tag from within the 
	3. In the Tags Panel, right-click and drag the hidden annotation tag from within the 
	parent tag, to below the parent tag so that it now becomes its own parent tag.

	4. Close the dialog box and return to the failed 
	4. Close the dialog box and return to the failed 
	Hides Annotation
	 list in 
	Accessibility 
	Checker. 
	Right click 
	Hides Annotation
	 > 
	Check Again 
	from the drop-down. 
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	PARENT figure tag
	PARENT figure tag
	PARENT figure tag


	Tag w/ alternate text
	Tag w/ alternate text
	Tag w/ alternate text


	HIDDEN annotation tag
	HIDDEN annotation tag
	HIDDEN annotation tag


	Annotation
	Annotation
	Annotation


	Figure
	PARENT figure tag
	PARENT figure tag
	PARENT figure tag


	Tag w/ alternate text
	Tag w/ alternate text
	Tag w/ alternate text


	PARENT annotation tag
	PARENT annotation tag
	PARENT annotation tag


	Annotation
	Annotation
	Annotation


	Other Elements Alternate Text
	Other Elements Alternate Text
	Other Elements Alternate Text

	This report checks for content, other than 
	This report checks for content, other than 
	figures, that requires alternate text (such 
	as multimedia, annotation, or 3D model). 
	You must make sure that alternate text 
	is always an alternate representation for 
	content on the page. If an element has 
	alternate text but does not contain any 
	page content, there is no way to determine 
	which page it is on.


	Since this section searches for content other than figures, there are various ways 
	Since this section searches for content other than figures, there are various ways 
	Since this section searches for content other than figures, there are various ways 
	to fix the failed elements. In most cases, the failed element is an invisible figure box 
	over a group of text such as an empty text box or a square outline with no stroke or 
	fill color. These invisible boxes typically comes from the original program when the 
	author fails to delete the excess box.

	To Fix:
	To Fix:

	1. Click 
	1. Click 
	Edit PDF
	 under the 
	Tools
	 tab, click the invisible box and delete.

	2. In the 
	2. In the 
	Accessibility Checker, 
	right click 
	Other Elements Alternate Text
	, then click 
	Check Again 
	from the drop-down.


	Figure
	In other cases, the failed element needs to be tagged as a figure and add the 
	In other cases, the failed element needs to be tagged as a figure and add the 
	In other cases, the failed element needs to be tagged as a figure and add the 
	alternate text manually.

	To Fix:
	To Fix:

	1. In 
	1. In 
	Accessibility Checker
	 panel, left-click 
	Other Elements Alternate Text
	 to 
	decollaspe the list of failed elements. Right-click 
	Element 1
	, click 
	Show in Tags Panel 
	from the drop-down and then the Tags Panel will automatically highlight the failed 
	element.

	NOTE: If the element does not have a tag, click 
	NOTE: If the element does not have a tag, click 
	Show in Content Panel.
	 The Content 
	Panel will automatically highlight the failed element.

	2. Identify the highlight content, select 
	2. Identify the highlight content, select 
	Reading Order
	 in the right panel. A 
	Reading 
	Order
	 dialog box will open, you will noticed that the buttons are unclickable. Drag 
	box, to the side so that the document is viewable.

	3. Drag and draw a rectangle over the highlighted element. The buttons within the 
	3. Drag and draw a rectangle over the highlighted element. The buttons within the 
	Reading Order
	 dialog box will become avaliable and click, 
	Figure.
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	Figure
	4. The element will become a single figure and an alternate text needs to be 
	4. The element will become a single figure and an alternate text needs to be 
	4. The element will become a single figure and an alternate text needs to be 
	added. Right-click within the figure box and click, 
	Edit Alternate Text
	 from the drop 
	down and an 
	Alternate Text
	 dialog box will appear. Manually type out an accurate 
	description of the figure then click 
	OK
	.

	NOTE: If you do not see the 
	NOTE: If you do not see the 
	Edit Alternate Text...
	 in the drop down, redraw the box 
	around the element, right click and choose 
	Delete Selected Item Stucture
	 from the 
	drop down. Repeat step 3-4 to recreate the tag and add an alternate text.
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	Rows
	Rows
	Rows

	This rule checks whether each TRow in a 
	This rule checks whether each TRow in a 
	table is a child of Table, THead, TBody, or 
	TFoot (See standard tag PDF section for 
	tag definitions).


	Use the Reading Order tool to make sure that tables are tagged correctly. If you 
	Use the Reading Order tool to make sure that tables are tagged correctly. If you 
	Use the Reading Order tool to make sure that tables are tagged correctly. If you 
	need to structure figures and text within the cells of your table, we highly suggest to 
	re-create the table in the authoring application before you convert it to an accessible 
	PDF. Adding tags on a cell level in Acrobat is a labor-intensive procedure.

	To Fix:
	To Fix:

	1. In 
	1. In 
	Accessibility Checker
	 panel, left-click 
	Rows
	 to decollaspe the list of failed 
	elements. Right-click 
	Element 1
	, click 
	Show in Tags Panel 
	from the drop-down and 
	then the Tags Panel will automatically highlight the failed element.
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	2. Identify  the <TR> element that is not a child tag of a <table> element. In order to 
	2. Identify  the <TR> element that is not a child tag of a <table> element. In order to 
	2. Identify  the <TR> element that is not a child tag of a <table> element. In order to 
	correct the structure, a <TR> must be placed with in a <table> element. Click and drag 
	the stray <TR> below the <table> element.

	NOTE: While dragging the tag, an underline will appear and follow your cursor within 
	NOTE: While dragging the tag, an underline will appear and follow your cursor within 
	the Tags Panel to indicate where you are dragging within the tag structure. The line 
	length will indicate whether you are placing the tag has a Parent, Child or Sibling tag.

	3. Return the 
	3. Return the 
	Accessibility Checker, 
	right click 
	Rows
	, then click 
	Check Again 
	from 
	the drop-down. Repeat steps 1-2 until all failed elements has been fixed.
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	Parent tag
	Parent tag
	Parent tag


	Child tag of <table> ALSO parent tag of <Span>
	Child tag of <table> ALSO parent tag of <Span>
	Child tag of <table> ALSO parent tag of <Span>


	Child tag of <Span> ALSO sibling tags of <Span>
	Child tag of <Span> ALSO sibling tags of <Span>
	Child tag of <Span> ALSO sibling tags of <Span>


	Sibling tag
	Sibling tag
	Sibling tag


	TH and TD
	TH and TD
	TH and TD

	In a proper table structure, TH and TD 
	In a proper table structure, TH and TD 
	are children of TR. This check fails when 
	a TH or TD is not nested under a TR 
	(See standard tag PDF section for tag 
	definitions).


	To Fix:
	To Fix:
	To Fix:

	1. In 
	1. In 
	Accessibility Checker
	 panel, left-click 
	TH and TD 
	to decollaspe the list of failed 
	hidden annotation element. Right-click 
	Element 1
	, click 
	Show in Tags Panel 
	from the 
	drop-down and then the Tags Panel will automatically highlight the failed element.


	Figure
	2. Identify the <TD> or <TH> element that is not a child tag of a <TR> element. In 
	2. Identify the <TD> or <TH> element that is not a child tag of a <TR> element. In 
	2. Identify the <TD> or <TH> element that is not a child tag of a <TR> element. In 
	order to correct the structure,  the <TD> or <TH> must be placed with in a <TR> 
	element. Click and drag the stray <TD> or <TH> below the <TR> element.

	3. Return the 
	3. Return the 
	Accessibility Checker, 
	right click 
	TH and TD
	, then click 
	Check Again 
	from the drop-down. Repeat steps 1-2 until all failed elements has been fixed.
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	Headers
	Headers
	Headers

	For accessibility, it’s necessary that all 
	For accessibility, it’s necessary that all 
	tables in the PDF have a header. To pass 
	this check, ensure that all tables contain 
	table header cells (See standard tag PDF 
	section for tag definitions). 


	To Fix:
	To Fix:
	To Fix:

	1. In 
	1. In 
	Accessibility Checker
	 panel, left-click 
	Headers 
	to decollaspe the list of failed 
	hidden annotation element. Right-click 
	Element 1
	, click 
	Show in Tags Panel 
	from the 
	drop-down and then the Tags Panel will automatically highlight the failed element.

	2. Identify the table row that needs the <TD> to be changed to <TH>.
	2. Identify the table row that needs the <TD> to be changed to <TH>.


	Figure
	Figure
	Figure
	decollapse
	decollapse
	decollapse


	collapsed
	collapsed
	collapsed
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	3. Show the table tags by clicking the 
	3. Show the table tags by clicking the 
	3. Show the table tags by clicking the 
	Reading Order
	 tool, right-clicking the table and 
	selecting 
	Table Editor
	.

	4. After you have identified which table row of <TD> tags need to be changed, open 
	4. After you have identified which table row of <TD> tags need to be changed, open 
	the Tags panel and return to the failed element. Double click the first <TD> and 
	manually change the tag to <TH>.

	5. Repeat steps 1-4 until all failed elements has been fixed.
	5. Repeat steps 1-4 until all failed elements has been fixed.
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	Regularity
	Regularity
	Regularity

	To be accessible, tables must contain the 
	To be accessible, tables must contain the 
	same number of columns in each row, and 
	rows in each column. You must ensure 
	that each table row has the same number 
	of columns or the ColSpan and RowSpan 
	properties of a cell are set properly to 
	account for all cells in a row.


	To Fix:
	To Fix:
	To Fix:

	1. In 
	1. In 
	Accessibility Checker
	 panel, left-click 
	Regularity 
	to decollaspe the list of failed 
	hidden annotation element. Right-click 
	Element 1
	, click 
	Show in Tags Panel 
	from the 
	drop-down and then the Tags Panel will automatically highlight the failed element.

	2. In the 
	2. In the 
	Tags Panel
	 panel, decollaspe the highlighted failed <table> element to 
	identifiy the irregular number of rows or columns.

	NOTE: This table example was created in Microsoft Word and exported with 
	NOTE: This table example was created in Microsoft Word and exported with 
	Create 
	PDF
	 feature under the 
	Adobe
	 tab. Notice that row 5 & 7 span the width of two 
	columns. This property must be manually specified within the 
	Table Cell Properties
	. 
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	decollapse
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	2 columns
	2 columns
	2 columns


	3 columns
	3 columns
	3 columns
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	table sample
	table sample
	table sample
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	2 columns
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	3 columns
	3 columns
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	2 columns
	2 columns
	2 columns


	Figure
	3. Show the table tags by clicking the 
	3. Show the table tags by clicking the 
	3. Show the table tags by clicking the 
	Reading Order
	 tool, right-clicking the table and 
	selecting 
	Table Editor
	.
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	4. Right-click the table and select 
	4. Right-click the table and select 
	4. Right-click the table and select 
	Table Editor Options
	. A 
	Table Editor Options
	 
	dialog box will open and show the meaning of the colored cells. 

	5. Identify which cells need to span multiple rows/column, then select the cell so that 
	5. Identify which cells need to span multiple rows/column, then select the cell so that 
	a light blue outline appears.

	6. Right-click the outlined cell and select 
	6. Right-click the outlined cell and select 
	Table Cell Properties
	. A 
	Table Cell 
	Properties
	 dialog box will open and show the cell type and attributes. 

	7. Below the 
	7. Below the 
	Attribute 
	section, indicate how many rows or columns the selected cell 
	spans then click 
	OK. 
	The change may or may no cause the cell to change color.

	8. After clicking 
	8. After clicking 
	OK
	, you may get a message stating that the cell change may cause 
	a malfunction in viewing the table. Disregard this message, continue steps 5-7 until 
	the table passes the regularity check and all columns and rows are indicated to its 
	appropriate span.
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	spans 2 columns
	spans 2 columns
	spans 2 columns
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	Summary
	Summary
	Summary

	Table summaries are optional unless 
	Table summaries are optional unless 
	the table data cannot be understood by 
	the accessibility reader. Summaries can 
	improve accessibility in complex data 
	tables or when the way in which the data is 
	read may be important.


	Provide a table summary for data tables where it is needed to make the data easier 
	Provide a table summary for data tables where it is needed to make the data easier 
	Provide a table summary for data tables where it is needed to make the data easier 
	to understand, or to provide instructions on the data reviewed.

	To Fix: 
	To Fix: 

	1. In 
	1. In 
	Accessibility Checker
	 panel, left-click 
	Summary 
	to decollaspe the list of failed 
	hidden annotation element. Right-click 
	Element 1
	, click 
	Show in Tags Panel 
	from the 
	drop-down and then the Tags Panel will automatically highlight the failed element.

	2. On the right panel, select the Reading Order tool. A 
	2. On the right panel, select the Reading Order tool. A 
	Reading Order
	 dialog box will 
	open and you will noticed that the buttons are unclickable.
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	Figure
	3. Right-click the table and select Edit Table Summary. A Table Summary dialog box 
	3. Right-click the table and select Edit Table Summary. A Table Summary dialog box 
	3. Right-click the table and select Edit Table Summary. A Table Summary dialog box 
	will open, type a description or summary about the table then click 
	OK
	. Repeat steps 
	1-3 until all tables have a summary and pass the acessibility check.
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	List Items
	List Items
	List Items

	The check reports whether each List Item 
	The check reports whether each List Item 
	(LI) is a child of List (L). When this check 
	fails, a Ll tag is out of order within the 
	stucture. Lists must have the following 
	structure: A List element must contain List 
	Item Elements. List Item Elements can only 
	contain Label Elements (Lbl) and List Item 
	Body Elements (LBody).  


	Depending on the software used to create or export the PDF (such as exporting from 
	Depending on the software used to create or export the PDF (such as exporting from 
	Depending on the software used to create or export the PDF (such as exporting from 
	Microsoft Words), some list structure will not be utilizing the label element tag <Lbl>. 
	Adobe InDesign CC will export with the <Lbl> tag to define bullet point, numbers, 
	and etc. Either structure will pass the check as long as they remain in the appropriate 
	order.
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	Original List
	Original List
	Original List
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	Exported from
	Exported from
	Exported from

	Microsoft Word
	Microsoft Word


	list element
	list element
	list element


	list item element
	list item element
	list item element


	list item body element
	list item body element
	list item body element


	no <Lbl> , bullet point 
	no <Lbl> , bullet point 
	no <Lbl> , bullet point 
	part of item tag
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	Exported from
	Exported from
	Exported from

	InDesign CC
	InDesign CC


	list element
	list element
	list element


	list item element
	list item element
	list item element


	label element
	label element
	label element


	bullet point is tagged 
	bullet point is tagged 
	bullet point is tagged 
	seperately


	list item body element
	list item body element
	list item body element


	To Fix:
	To Fix:
	To Fix:

	In 
	In 
	Accessibility Checker
	 panel, decollaspe the 
	List Items 
	section to view the 
	failed elements. Right-click 
	Element 1
	 > 
	Show in Tags Panel. 
	The Tags Panel will 
	automatically highlight the failed element.

	2. Identify the highlighted element and how it is misplaced. In this example, the 
	2. Identify the highlighted element and how it is misplaced. In this example, the 
	<LI> tag is not in the correct order. <LI> is a child element of a <L> tag and must be 
	manually dragged to be reposition within the <L> tag.

	3. Repeat steps 1-2 to restructure misplaced list elements. If this check continues 
	3. Repeat steps 1-2 to restructure misplaced list elements. If this check continues 
	to fail, it is highly recommended to recreate  the document or simplify the list in its 
	original file prior to exporting it as a PDF.
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	Lbl and LBody 
	Lbl and LBody 
	Lbl and LBody 

	When this check fails, the list structure is 
	When this check fails, the list structure is 
	not in appropriate order due to a misplaced 
	Lbl or LBody tag. 


	Please refer to the section on 
	Please refer to the section on 
	Please refer to the section on 
	List Items
	 for the correct order of a list structure. 

	To Fix: 
	To Fix: 

	1. In 
	1. In 
	Accessibility Checker
	 panel, decollaspe the 
	Lbl and LBody 
	section to view the 
	failed elements. Right-click 
	Lbl/LBody 1 
	> 
	Show in Tags Panel. 
	The Tags Panel will 
	automatically highlight the failed element.


	Figure
	2. The highlighted element indicates the Lbl or LBody tag that is out of order. Refer to 
	2. The highlighted element indicates the Lbl or LBody tag that is out of order. Refer to 
	2. The highlighted element indicates the Lbl or LBody tag that is out of order. Refer to 
	the correct list order and determine where the misplaced tag should be repositioned.

	3. Manually drag <LBody> tag below a <LI> tag. If there is a <Lbl> tag present, make 
	3. Manually drag <LBody> tag below a <LI> tag. If there is a <Lbl> tag present, make 
	sure <LBody> is placed after <Lbl>.

	4. Repeat steps until all the misplaced tags has been appropriately repositioned. If 
	4. Repeat steps until all the misplaced tags has been appropriately repositioned. If 
	this check continues to fail, it is highly recommended to recreate the document or 
	simplify the list in its original file prior to exporting it as a PDF.


	Example of Correct Order
	Example of Correct Order
	Example of Correct Order


	Incorrect Order
	Incorrect Order
	Incorrect Order
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	Before
	Before
	Before


	After
	After
	After
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	Appropriate Nesting
	Appropriate Nesting
	Appropriate Nesting

	This rule checks nested headings. When 
	This rule checks nested headings. When 
	this check fails, headings are not nested 
	properly.


	Headers must be in a linear descending order inline such as H1, H2, H3, and does 
	Headers must be in a linear descending order inline such as H1, H2, H3, and does 
	Headers must be in a linear descending order inline such as H1, H2, H3, and does 
	not skip or ascend in order. However headers can be repeated as long as the order 
	does not ascend, such as H1, H2, H2, H3.

	Headers must also be in linear descending order when pertaining to parent and child 
	Headers must also be in linear descending order when pertaining to parent and child 
	tags. For example, a H3 header must be a child of H2. 

	To Fix:
	To Fix:

	In 
	In 
	Accessibility Checker
	 panel, decollaspe the 
	Appropriate Nesting 
	section to view 
	the failed elements. Right-click 
	Element 1
	 > 
	Show in Tags Panel. 
	The Tags Panel will 
	automatically highlight the failed element.
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	parent and 
	parent and 
	parent and 
	child


	inline
	inline
	inline
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	2. Identify the highlighted element and how the heading tag is not in its appropriate 
	2. Identify the highlighted element and how the heading tag is not in its appropriate 
	2. Identify the highlighted element and how the heading tag is not in its appropriate 
	order. 

	3. Change the heading tag to its appropriate order. In the 
	3. Change the heading tag to its appropriate order. In the 
	Tags Panel
	, double-click 
	tag and type in correct tag.
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	Resources
	Resources
	Resources

	Information and content has been collected  
	Information and content has been collected  
	rephrased from these links. All credits for 
	copied content goes to the rightful owner 
	of these web pages. All screenshots and 
	images are original. 
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